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Introduction to IMOS Administration

About IMOS Administration

This manual is for administrators of IMOS, the Integrated Maritime Operations System from Veson
Nautical Corporation. It contains guidelines for developing a disaster contingency plan and
instructions for setting up security.

For hardware and software information, see the IMOS Requirements and Recommendations
document.

For installation information, see the IMOS Installation Manual.

Sequence of Administration Steps

1. Install and configure IMOS. For more information, see the IMOS Installation Manual.

Log on as an administrator.

2
3. Set up IMOS Security.
4

Complete the following setup tasks. For more information about these tasks, see the IMOS
Manual or IMOS Help.

a. Edit and/or enter information in the term lists.
b. Enter information into the Address Book.
c. Edit and/or enter vessel information.

d. Edit and/or enter cargo names.

Developing a Disaster Contingency Plan

This section contains general guidelines for developing a disaster contingency plan. During the
implementation phase, Veson Nautical reviews the existing disaster recovery hardware and
software plan and tailors this information to your requirements. This is particularly important if
other applications will be communicating with IMOS via the XML interfaces or otherwise.

Existing best practices apply to IMOS. The core of IMOS resides in the database, and the most
important element of disaster recovery is to ensure that users are always able to access an up-to-
date database. Several third-party vendors have applications for best practices that you should
consider in developing a complete disaster recovery plan.
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Backup Procedures (Client-Hosted Pilot)

We recommend the following backup procedures to ensure that IMOS is highly available.

¢ Database backups: It is very important to keep frequent backups of the database. We
recommend at least one full backup daily. These backups should also be sent electronically to
an offsite facility that serves as the secondary source in the event of a disaster at the primary
site. Typically, it is sufficient to keep two weeks of backups in disk storage and to archive older
backups to tape. Using one of these archive files, it is possible to fully restore the state of the
IMOS system. You may need to consider exogenous states, such as systems that link to IMOS,
separately.

¢ Application and Configuration file backups: Veson Nautical keeps a complete record of all
application programs installed at a client site. However, we recommend that you back up your
application folder any time the configuration changes (for program updates, Configuration file
changes, etc.). Any information not stored in the database will exist under the root IMOS
installation tree; the application uses no registry settings.

¢ Client backups: IMOS is designed to be installed on the server and keep all states in the
database, so no specific handling is required for client machines beyond standard disaster
recovery procedures (restoring the operating system, any other local applications, etc.).

Backup Procedures (VNC-Hosted Pilot)

¢ Database backups: Pilot databases are hosted at PEER 1's co-location data center in New
York, New York, which features UPS, diesel generator power, and fire suppression. Databases
are backed up daily to a separate physical drive and then backed up (disk-to-disk over the
Internet) to a RAID 5 disk array in our Boston office and checked for integrity. Two weeks of
database backups are retained.

e Recovery: In the event recovery is necessary, the pilot environment will be restored by
Boston-based VNC staff from the most recent available backup. The recovery will be
completed within two business days. The following will be restored:

e IMOS application
e Pilot-specific IMOS configuration
e Most recent available backup of IMOS database(s)

¢ Remote desktop user(s) associated with the pilot (account credentials only; passwords
may need to be reset)

No other data (for example, files you create or store on our system) will be restored without
prior arrangement.

Recommended Hardware Configuration for Off-Site Installation

In the event of a catastrophic failure at the primary site, we recommend the setup of an off-site
IMOS server environment. This includes the database and applications, which can be restored at
any time using the backups outlined above. Generally, we recommend Terminal Server access to
the off-site server, so that users can gain access to the system with just an Internet connection.
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Security

Logging On and Off as an Administrator

Logging On

To access IMOS Security, you must log on as an administrator. Follow these steps.

1. Double-click E on your desktop. The Login page appears.

VESON

N A UTICAIL

Ilzer name:

Pazzwornd:

Ervironment; I - |

Login H Cancel ‘

IMOS Login Page

2. Enter your User name and Password.

Note: The initial administrator user name and password are set up by Veson Nautical.
Be sure to change the password.

3. Click Login. IMOS appears.
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&= veson Nautical - Integrated Maritime Operations System (IMOS) [_ 1Ol x]
File Edit Help

TRADING admin | demaimos

TRADING CENTER

Trading P&L Summary

FFA List » Record Trade

Cargo List # Cargo (new/edit)
TC List » TC-In management
Market Data » Trade Route (new/edit)

@ Market Data (nesw/edit)

[ 4

IMOS

Logging Off
When you are finished using IMOS, do one of the following.
. Click [X].
e On the File menu, click Exit.

e On the File menu, click Logoff. On the Login page, click Cancel.

About Groups and Users

IMOS recognizes two types of users for assigning access rights:

e Groups have group access rights. Groups can belong to other groups. A group acts as a
template: Any user in a group inherits all the access rights of the group.

e Users have individual access rights. Users can belong to one or more groups, but they do not
have to belong to any groups.

Users' overall access rights are a combination of their group and individual access rights.
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Setting Up Security

IMOS Security is designed to protect data and prevent unauthorized access to the IMOS
environment. The Security system manages all user rights on the IMOS system. For each user
and/or group, you can assign rights to perform the functions related to each module and object in
IMOS.

To set up IMOS Security:
1. Click the Data Center tab.

B veson Nautical - Integrated Maritime Operations System (IMDS) M=l B

File Edit Help

TRADING CHARTERING

A CENTER

Address Book

+ Cargo Names

¢ Distances
: Ports

+ Vessels

ﬂ Security

DEMURRAGE | DATACENTER ONBOARD

TERM LISTS

Charter Party Terms
w» Charter Party Forms
= Freight Codes

= Laytime To Commence
= Laytime Types

» Loading Costs

» NOR To Tender

w» Other Loading Tetms
» Shifting Terms

3 SHIMC/SHEX Terms
w» Standard Paragraphs
» Gtandard Rate Tables
» Time To Tender

» Time Used

» Working Days
Currencies

@ Currency Types

» Exchange Rates

admin / demoimos

Delays & Weather
»» Beaufort Scale

» Delay Reasons

» Delay Types

w Sea States

» Swell States
Other

s Burker Rates

» Class Societies

» Departrments/ Teams
» Fuel/Lube Types
» OPA Rates

» Operations Ledger
s Product Codes

» Trade Areas

» Units of Measure
= Wessel Daily Cost
» Vessel Fleets

» Vessel Types

IMOS Data Center

2. In the Data Center, click ﬂ Securit?.
|

| | Ei | &

edit | del PatJones Pat P. Jones ppi ppjones@company.com  User Group A
edit | del Charterers Group

edit | del Group A Group

edit | del Mary Smith Mary J. Smith mjs  mjsmith@company.com  User Group A
edit | del John Roberts John J. Roberts jir  jiroberts@company.com  User Charterers
edit | del Admin Systemn Administrator admin@company.com User

|
IMOS Security

R
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We recommend that you create groups and assign rights to them before you create individual
users. You might find it more efficient to categorize users in groups and then adjust rights for
individuals, rather than starting from scratch for each user.

To set up users and groups:
1. Create groups and assign module and object rights.
2. Create users.
a. Assign users to groups.
b. Assign user module and object rights or edit user rights inherited from groups.

Once these steps are complete, users can use their credentials on the Login page. If IMOS verifies
their credentials, IMOS starts.

Creating groups and creating users are nearly identical tasks, with the same window tabs:
e User

e Membership

e Module Rights

e Object Rights

10
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Creating a New Group

To create a new group:

ut
1. In IMOS Security, click & . The Properties for Group window User tab appears.
Properties for group !E[

User | Membership | Module Rights I Object Rights |

Group name: ICharterers|

= Windows Authentication
& M5 Authentication

Ok | Cancel |

Properties for Group, User Tab

2. Enter a name for the group that describes the members’ functions or rights, for example,
Chartering Users, Operations Users, Team X Users, etc.

IMOS Administration Manual, Version 5
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Adding or Removing Group Members

3. To set up group members, click the Membership tab.

4.

Properties for group !El E
User  Membership IModuIe Rights | Object Rights |

Membership:

Mary Smith
[] John Roberts
Admin

oK | Cancel |

Properties for Group, Membership Tab

The Membership tab contains a list of IMOS users. Each user name is preceded by a check

box. To add or remove a group member, click the user’s check box.
L] = The user is not a member of the group.

= The user is a member of the group.

Note: We recommend that you do not assign the administrator to any groups, but assign all
rights individually. As a member of a group, the administrator might be denied rights if the

group has any rights actively denied.

12
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Adding or Removing Group Module Rights

5. To set up group rights to modules and actions, click the Module Rights tab.

Properties for group

User I Membership IObject Rights|

[] Trading

----- [[] Gereral Trading
----- [ Trade summary
----- [] Market data

----- [[] Trade route

----- [ FFA list

----- [ Carga list

----- [ TClist

----- [[] Record trade .
[ Chartering

----- [] General Chartering

----- [] Fix an estimate

----- [[] Revise a fixed estimate

----- [[] Schedule a fixture

[[] Operations

----- [[] General Operations

----- [T Operations Reparts

----- 1 Prnlinn j

|»

[0]4 | Cancel |

Properties for Group, Module Rights Tab

6. The Module Rights tab lists the modules of IMOS and the actions associated with them. Select
the group’s rights for the module actions.

e Each module name is preceded by a check box. To expand or collapse the list of actions
for a module, double-click the module’s check box.

e When a module list is expanded, each action is preceded by a check box. To change the
group’s right to perform a task, click the check box. Each time you click, the right
changes.

[l = No access: The group does not have the right to perform the task.

[®] = Read-only: The group can retrieve information from files and view reports. General
rights, such as General Chartering, have this option, but specific actions, such as Fix an
estimate, do not.

= Read/Write: The group has full ability to store and update information in the
database.

Note: A user’s rights include the individual user rights plus the rights from any groups in
which the user is a member. If a user has different rights, either assigned individually or from
groups, the highest access rights apply.
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Adding or Removing Group Object Rights

7. To set up group rights to objects, click the Object Rights tab.

Properties for group !El

User

Object access: |<view all objects = "l

I Membership I Module Rights  Cbject Rights I

O

Vessel Type ﬂ
-] CCMA

] MMTA

- [] ERSTWINDS J
] KONIG

- [] WESTWINDS

[ ICH

-] SEYCHELLES

-] OTHERS

[ 5CM

-] 5TAR

[ Wessel

D ABCD

o [] ADAM

E ADRI =

Ok | Cancel |

Properties for Group, Object Rights Tab

8. The Object Rights tab lists the categories of objects in IMOS and the objects associated with

them.

Select the group’s rights to the objects.

e To filter the list of objects, select an object category from the menu:

View all objects
Company
Vessel Type
Vessel

Pool

e Each object is preceded by a check box. To expand or collapse the list of objects for a
category, double-click the category’s check box.

e When an object category list is expanded, each object is preceded by a check box. To
change the group’s right to an object, click the check box. Each time you click, the right
changes.

[1 = The group does not have the right to the object.

] = Read-only: The group can retrieve information from files and view reports.

= Read/Write: The group has full ability to store and update information in the
database.

Note: A user’s rights include the individual user rights plus the rights from any groups in
which the user is a member. If a user has different rights, either assigned individually or from
groups, the highest access rights apply.

9. When you finish creating the group, click OK.

14
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Creating a New User

To create a new user:

1. In IMOS Security, click 3_] The Properties for user window User tab appears.
Properties for user !E[

User | Membership | Module Rights I Object Rights |

Lser name: IPat Jones

' Windows Authentication
" IMOS Authentication

Password: I

Confitm password: I

Full narme: |Pat . Jones
Initials: [pr3
Ernail: Ippjones@company.coﬂ

r Security administrakor

Ok | Cancel

Properties for User, User Tab

2. Enter the following information:
e User name: Up to 25 characters.
e Authentication: Select one.

¢ Windows Authentication: If you select this option, IMOS uses Windows login
credentials for authentication, and the user does not have to log in a second time with
possibly a different user name and password. If the user changes the Windows
password, it is also changed here.

¢ IMOS Authentication: If you select this option, enter a Password for the user (at
least five characters), and then enter it again to Confirm the password.

e Full name: The user’s full name.
e Initials: The user’s initials.
e Email: The user’s email address.

e Security administrator: To make this user a Security administrator, select this check
box.

IMOS Administration Manual, Version 5



Adding or Removing Group Membership

3. To set up group membership for the user, click the Membership tab.

Properties for user =] B3

4.

User Membershlp Module Rights I Object Rights |

Membership:

[] Banks/Bear Pool Access
[T UPT Pool Access

[] UPT Users

[[] Data Center Managers
[ Data Center

[T Accounts Managers
[] Accounts

[[] Operations Managers
[] Operations

[[] Chartering Managars
[ Chartering

[ C5M Users

[ M3C Users

[] DTML Users

[ IMO3S Users

Ok

Cancel

Properties for User, Membership Tab

The Membership tab contains a list of user groups. Each group name is preceded by a check
box. To add the user to a group or remove the user from a group, click the group’s check box.

[l = The user is not a member of the group.

= The user is a member of the group.

16
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Adding, Removing, or Overriding User Module Rights

5. To set up user rights to modules and actions, click the Module Rights tab.
Properties for user =] B3

| object Rights |

User IMembership

[] Trading

----- [ @eneral Trading

----- [[] Trade summary

----- [] Market data

----- [] Trade route

----- [ FFalist

----- [[] Cargo list

----- [ TClist

----- [[] Record trade

[] Chartering

----- [[] Gereral Chattering
----- [] Fix an estimate

----- [[] Revise a fixed estimate
----- [ Schedule a fixture
[] Operations

----- [[] General Operations
----- [T Operations Reparts

----- 1 Prnlinn j

| »

oK | Cancel |

Properties for User, Module Rights Tab

6. The Module Rights tab lists the modules and the actions associated with them. Select the
user’s rights for the module actions.

e Each module name is preceded by a check box. To expand or collapse the list of actions
for a module, double-click the module’s check box.

¢ When a module list is expanded, each action is preceded by a check box. To change the
user’s right to perform a task, click the check box. Each time you click, the right changes.

L] = Either the user does not have the right to perform the task, or the user is a member
of a group with the right.

[®] = Read-only: The user can retrieve information from files and view reports.

= Read/Write: The user has full ability to store and update information in the database.

™ = Denied: The group right to perform the task is overridden for this user.

Note: A user’s rights include the individual user rights plus the rights from any groups in
which the user is a member. If a user has different rights, either assigned individually or from
groups, the highest access rights apply.

IMOS Administration Manual, Version 5
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Adding, Removing, or Overriding User Object Rights

7. To set up user rights to objects, click the Object Rights tab.

Properties for user

User I Membership | Madule Rights : ©

[=] E3

Object access: |<view all objects= j

[ wessel Type ;I

----- [[] SEVCHELLES
----- [[] OTHERS

----- 0 sors <]

oK | Cancel |

Properties for User, Object Rights Tab

8. The Object Rights tab lists the objects in IMOS. Select the user’s rights to the objects.

To filter the list of objects, select an object category from the menu:
e View all objects

e Company

e \Vessel Fleet

e Vessel

e Pool

Each object category is preceded by a check box. To expand or collapse the list of objects
for a category, double-click the category’s check box.

When an object category list is expanded, each object is preceded by a check box. To
change the user’s right to an object, click the check box. Each time you click, the right
changes.

L] = Either the user does not have the right to the object, or the user is a member of a
group with the right.

Rl = Read-only: The user can retrieve information from files and view reports. General
rights such as General Chartering have this option, but actions such as Create a Voyage
Estimate do not.

= Read/Write: The user has full ability to store and update information in the database.

™ = Denied: The group right to perform the task is overridden for this user.

Note: A user’s rights include the individual user rights plus the rights from any groups in
which the user is a member. If a user has different rights, either assigned individually or from
groups, the highest access rights apply.

18
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9.

When you finish creating the user, click OK.

Editing a User or a Group

To edit a user or a group:

1.

On the Security page, in the row for the user or group, click the edit link. The Properties
window appears.

Click the tab on which you want to make a change.

Make any necessary changes to the user information or group information.

e To change the password for a user with IMOS Authentication, select the Change

password check box and then complete the Password and Confirm password fields.

When you finish making changes, click OK.

3
To update the Security page, click g

Deleting a User or a Group

To delete a user or a group:

1.
2.

On the Security page, in the row for the user or group, click the del link.

A message asks if you are sure you want to delete the user or the group. Click Yes.

IMOS Administration Manual, Version 5
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